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Improve Your Image: Acquiring, Enhancing, & Using Digital Images. 

http://www.wam.umd.edu/~toh/image/ (Paint Shop Pro Studio)

http://home.swfla.rr.com/ohaver/ImageWorkshop/ (Paint Shop Pro X)
Presented by Tom and Mary O'Haver 

toh@umd.edu       ohaverma@verizon.net 

The complete set of current workshop handouts are available here in PDF format: Section A (6 pages) ; 
Section B (11 pages) ; Section C (7 pages) ; Section D (2 pages) ; Section E (4 pages) ; Section F (5 pages) .

Contents of the workshop CD-ROM (version 21)

Individual handouts for Part 1:
• How to use the CD-ROM.rtf  : How to use the CD-ROM distributed in this course. (1 page - WordPad 

or MS Word document) 

• DigitalCamera.rtf  : Choosing a Digital Camera. (2 pages - WordPad or MS Word document) 

• Photo File Basics  : Photo File Basics. Downloading pictures from your digital camera. Organizing and 
re-naming your photo files. Printing your pictures. Sending pictures via email. (4 pages - WordPad or 
MS Word document). Also available in Adobe Acrobat PDF format. 

• CommonTasks.rtf  : Using the Common Tasks menu in Windows XP. (1 page - WordPad or MS Word 
document) 

• FreeSpace  : How many digital photos can you fit on your hard disk? (1 page - Adobe Acrobat PDF 
format). Also available in WordPad or MS Word document format (Print in Landscape orientation). 

• Picasa Photo 2 Organizer.rtf  : Using the Picasa Photo Organizer, a free photo organizer that finds all 
the photos on your computer (2 pages - WordPad or MS Word document). 

• Photo Downloading and Organization in Picasa 2  : Step-by-step workshop activity - downloading 
photos from a CD and organizing them in Picasa 2 (1 page - WordPad or MS Word document). 

• Task1forPicasa.rtf  : Practice tasks for Picasa 2. Step-by-step workshop activity - basic photo fixes in 
Picasa 2. (2 pages - WordPad or MS Word document). 

• OrderingPrints.rtf  : Step-by-step workshop activity - How to Order Prints from Walmart from within 
Picasa 2 (1 page - WordPad or MS Word document). 

• How to Install PSP X.rtf  : Step-by-step instructions for installing Paint Shop Pro X on your Windows 
computer. (1 page - WordPad or MS Word document) 

• Getting Started  : Getting Started with Paint Shop Pro X. (1 page - WordPad or MS Word document) 

• Summary.rtf  : Summary of Common Paint Shop Pro X Operations (1 page - WordPad or MS Word) 

• Paint Shop Pro Reviews.rtf  : Critics reviews of various versioans of Paint Shop Pro (1 page - WordPad 
or MS Word 

• Problems using Paint Shop X.rtf  : Common Problems using Paint Shop Pro X Operations (1 page - 
WordPad or MS Word document) 

• Scanner.rtf  : Choosing and Using a Scanner. (1 page - WordPad or MS Word document) 
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• Epson Perfection 4870 Scanner.rtf  : Review of a high-quality scanner suitable for prints, text, slides, or 
negatives. (1 page - WordPad or MS Word document) 

• Tasks1.rtf  : Paint Shop Pro Practice Tasks for Part I (2 pages - WordPad or MS Word document) 

• Tasks2.rtf  : Paint Shop Pro Practice Tasks for Part II (2 pages - WordPad or MS Word document) 

• What Program.rtf  : What Program Should I Use? - Digital photo tasks and how to do them.(2 pages - 
WordPad or MS Word document). 

Individual handouts for Part 2:
• Overview.rtf  : Overview of Digital Imaging and Photography (1 page - WordPad or MS Word 

document) 

• Paint Shop Pro Tools.pdf  : Overview Tools in Paint Shop Pro X (2 pages - WordPad or MS Word) 

• Tasks3.rtf  : Paint Shop Pro Practice Tasks III (2 pages - WordPad or MS Word document) 

• ShutterFly.rtf  : How to Send Photos on the Internet using Shutterfly (2 pages - WordPad or MS Word) 

• Making slideshows.rtf  : An overview of various ways to make sideshows of digital still images, both for 
viewing on the computer screen and on the television screen. (2 pages - WordPad or MS Word) 

• DZslideShow.doc  : How to make a simple slideshow of digital images using DZSlideshow. (WordPad or 
MS Word document) 

• MemoriesOnTV3.pdf  : Using Memories On TV 3.0 to make Video Slide Shows of your Digital Pictures. 
Memories On TV is a commercial ($50) program that you can use to make professional-quality Ken 
Burns-type documentary video slide shows of digital pictures with background music and narration that 
can be played on a DVD player. The CD-ROM contains a fully-functional evaluation version of this 
software. There is also a handout for the older version 2. (2 pages - WordPad or MS Word document) 

• Type of disks table.pdf  : Types of 5" disk media, how to read them and how to make them. (1 page - 
PDF document) 

• CDs and DVDs.rtf  : Comparison of CD-ROM, CD-R, CD-RW, audio CD, and DVDs (2 pages - 
WordPad or MS Word document) 

• Ripping and burning WMP 10.rtf  : Copying and burning audio CDs using Windows Media Player 10 
(1 page - WordPad or MS Word document) 

• Layers.rtf  : How to take people and things out of one picture and put them into another picture, using 
Paint Shop Pro X (1 page - WordPad or MS Word document). See the Layer demo folder for some 
examples. 

• ChangingBackgrounds.rtf  : How to change the background of portraits and group photos, using Paint  
Shop Pro X (1 page - WordPad or MS Word document). 

• AddressLabels.rtf  : How to make photo address labels using Paint Shop Pro X (1 page - WordPad or 
MS Word document). 

• Painting.rtf  : Converting a Photo into a Painting in Paint Shop Pro X (1 page - WordPad or MS Word 
document). See the Artistic effects folder for some examples. 

• Colorizing.rtf  : Adding Color to Black and White Photos. (2 pages - WordPad or MS Word document) 
See the Photos to Colorize folder for some photos to practice colorizing. 

• It's All About Color  : Color extraction and manipulation in Paint Shop Pro X  : (1 page - WordPad or 
MS Word document). Not for Paint Shop Pro Studio. See the Artistic effects folder for some examples. 

• Automating Repetitive Actions in   Paint Shop Pro X  : (2 pages - WordPad or MS Word document). 
Not for Paint Shop Pro Studio 
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• Summary of Common   Adobe Photoshop Elements   Operations   : (1 page - WordPad or MS Word 
document). For Adobe Photoshop Elements only. 

Pictures, software, and Interent Links
• Software Installers folder  : Image editing software for Windows and Macintosh. See the ReadMe file in 

this folder for a list of software and instructions. The main software that we use in the course is Paint 
Shop Pro X. 

• Example pictures folder  : Pictures used in the demo portion of the workshop and for the Practice Tasks. 

• Links to related topics and activities  : Web shortcuts to topics and activities related to digital imaging, 
including: Art and Drawing lessons, Cameras and scanners, Color, Classroom activities, Symmetry, 
Reviews of Photo Editors, Web Photo Album sites, Creative and craft projects, and other topics. 

• Layer demo folder  : Examples of the use of layering to produce composite photographs. See the 
handouts "How to take people and things out of one picture and put them into another picture in   Paint   
Shop Pro X  "   and How to change the background of portraits and group photos, using   Paint Shop Pro X  . 

• Photos to Colorize folder  : Collection of black-and-white photos (mostly portraits) to practice 
colorizing. See the handout "Adding Color to Black and White Photos in   Paint Shop Pro  "   for detailed 
instrucitons. 

• Artistic effects folder  : Examples of the use of the Brush Strokes effect combined with layering to 
produce painting-like artwork from photographs. See the handout "Converting a Photo into a Painting in 
Paint Shop Pro X  "  . 

• FreeClipArt folder  : Royalty-ree clip art downloaded from the Internet, in various file formats. 

Tutorials
• Presentation slide show  : Illustrated introduction to basic digital photographic terms and concepts. 

(Open index.html with Web browser) 

• Digital Image Literacy  : Questions and Answers about Digital Imaging (Approx. 6 pages - Open 
image.html with Web browser) 

• Paint Shop Pro Tutorials folder: Includes: 
• Automatic photo enhancement   
• Manual Color correction   
• Drawing cartoons with vector graphics   
• Red Eye removal   
• Photo Restoration   
• Adding Color to Black and White Photos   
• Colorizing Portraits   
• Colorizing Black & White Photos   
• Background Eraser   
• Background Eraser Part 2   
• Simple Extruded Text   
• Straightening Photos   
• Removing Image Elements with the Clone Brush   
• Using the Mesh Warp Tool   
• Basic Scripting and Batch Processing  . 

Also includes folders containing "Links to tutorials on the Web", tutorials on "Fixing Flash 
Photos" and "Detail From Shadows". 
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Especially For Teachers
• Introduction to IrfanView.doc  : Introduction to IrfanView 3.85, a basic freeware picture viewer and 

editor that you can legally install on all the computers in your classroom or computer lab. (WordPad or 
MS Word document) 

• IrfanView Summary.doc  : Summary of Common IrfanView 3.85 Operations (WordPad or MS Word 
document) 

• DigitalCameraUses.doc  : A collection of ideas for using digital cameras in the classroom, collected 
from teachers. (WordPad or MS Word document) 

• StudentProjects   and Gulf View Art Gallery: Examples of school projects created with scanner and 
digital camera. (Open with Web browser) 

• See also Links to related topics and activities for other ideas for teachers. 

(c) Tom O'Haver, April, 2006

How to use the workshop CD-ROM
The workshop CD-ROM is the one labeled "Improve your Image (Digital Image)".  It is 
used for three purposes.

A. Installing software.  Some activities in the workshop describe the installation of 
software, contained in the "Software installers" folders. Once the software is 
installed on your computer, you do not need to keep the CD-ROM in your computer 
in order to use the software on your own images.  This software can be used to view 
and edit any pictures contained anywhere on your computer, not just the ones on 
this CD-ROM.

B. Images for the workshop activities.  These images are sample pictures used only in 
the workshop practice tasks and other activities.  You can open these images in any 
image editor.  To acess these pictures, you must have the CD-ROM in the 
computer's CD drive, or you can copy those folders over to your hard disk (so you 
won't have to locate the CD-ROM every time you want to practice on those images).

C. Handouts, tutorials, and Web links.  All of the handouts in the course are on this 
CD-ROM. To access these materials:

1. Insert the Workshop CD-ROM into your computer's CD drive, label side up. If the 
"Autoplay" pops up, just close it.

2. Open (double-click or right-click and select Open) "My Computer".  Open the CD-
ROM icon.  The handouts are shown as word processor icons.  DOuble-click 
them to open.

3. The ReadMe file on this disc is a table of contents of the CD-ROM, with links to 
all the additional materials.  Click on the links to access the materials.
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Student Project Examples
by the students and teachers of Fairland Elementary School

Student-Produced Projects on this CD

Famous Marylanders, 4th grade (2000) We're Going Batty!, 5th grade (1998)
American Tall Tales, 5th grade (1998) 5th grade science unit on Structures (1998)
Cooperative project with San Juan Evangelista School, 
Santiago, Chile (1998) Beanie Baby ABC Book (1998)

Pocahontas Slide Show, 5th grade (1998) Black History Commemorative Stamps, 5th 
grade (1998)

"Old Yeller" Slide Shows, 5th grade (1997) American Tall Tales, 5th grade (1997)
Bugs!, Special Education , grades 1-5(1997) Frog Research Project, 4th grade (1997)

Circle Stories, 4th grade (1996) Commemorative Stamps for the Bill of Rights, 
5th grade (96-97)

Tessellations Project, 5th grade (95-96) Native American Storyteller Project, 5th grade 
(95-96)

Electronic Self-Portraiture 4th grade (95-96) Maryland POGs! 4th grade (94-95)
Native American Commemorative Stamp Designs, 5th 
grade (94-95)

Famous Americans Biography Book Reports, 
5th grade (94-95)

Tessellations Project, 5th grade (93-95) Other Student Computer Projects, 5th grade 
(92-95)

Ready-To-Use Plans and Handouts for Class Projects on this CD

• I Have A Dream   

• Explorers Mini-Poster   

• Using Computers to Make Math Resources   

• Making Science Trade Books for the Lower Grades   

• Autobiograpical Stamp   and grading sheet 

Mail we have received from visitors to our site! 

"Fairland's students are not just using the Web; they are helping to build it." 
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Using the Common Tasks menu in Windows XP
The Common Tasks menu is a panel on the left of every open folder window that lists 
common tasks. It makes it  easier to do the most commonly performed tasks, like 
copying and moving files and folders, renaming, deleting, printing and e-mailing files. 

Showing the Common Tasks menu
If your computer does not show a menu of common tasks on the left-hand side of every 

open folder, perform the following steps (you only need to do this once).
1.  Open any folder by double-clicking it (e.g. the My Documents folder on the 

desktop).
2.  Pull down the Tools menu
3.  Click on Folder Options.
4. Click where is says "Show common tasks in folders" at the top.
5. Click OK.  Windows applies this setting to every folder.  

Note: You only have to do this once.  Windows will remember this setting.

Using the Common Tasks menu
To perform one of the tasks listed, just click it and Windows will perform this task.  The 

tasks that are listed will change depending on the types of files in the folder and 
whether you have one or more files selected.

To select a file, click on it once, so that it is highlighted.  
To select two or more files, click once on the first file, then hold down the Ctrl key 

(lower left corner of the keyboard) and click on the other files that you wish to select 
while holding hold down the Ctrl key.  All the selected files will be highlighted.

To select all the files in a folder, pull down the Edit menu and click Select All.
So, for example, if you want to rename, or delete, or print a file, select the file (by 
clicking on it once) and then click Rename this file, or Print this file, or Delete this 
file in the common tasks panel.  
For another example, to move a file to another location (i.e. to another folder or disk), 
select the file (by clicking on it once) and then click Move this file in the common tasks 
panel.  Windows displays a box in the middle to the screen that asks you to select 
(click on) the place (folder or disk) where to want the file moved, then click the Move 
button to complete the task.  You can also move folders this way.  

Changing the folder type for photo and music files
Pull down the View menu and select Customize this folder.... Click the pop-up menu 
at the top ("What kind of folder do you want?") and select "Pictures" or "Music" and 
click OK. This setting will change add Picture Tasks or Music Tasks to the top of the 
common tasks.

Tom O'Haver, February 2005
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